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Preface

The DEWETRON Explorer is standalone software designed as a device manager for DEWETRON
hardware. Its primary functions include conducting hardware functionality checks, performing firmware
updates, and simulating hardware.
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1 Installation

DEWETRON Explorer is installed automatically when installing TRION hardware drivers by running
the installation program DEWETRON-TRION-Applications-xxx.exe. The installation process differs
depending on the operating system.

Windows Installation

The Windows installation file can be found in the directory files\drivers\01_TRION\DEWETRON
TRION X.x of the delivered Install Media USB stick or downloaded from https://ccc.dewetron.
com/. The installation process is straight forward: Run the installation file, click on install and wait
until the process is finished.

Installation Process

a \ TRION Appiica O DEWETRON TRION Appliations setop - x B DEWETRON TRIO

DEWETRON TRION Applications DEWETRON TRION Applications DEWETRON TRION Applications
Ple L ment
A ETRON A Setup Progress A Setup Successful

DEWETRON | DEWETRON DEWETRON

Action 11:35:1

Version 7.002762 Cencel Version 7002762 Close

Figure 1.1: Windows installation process.

If another version of DEWETRON Explorer is already installed, the existing version must first
be uninstalled.

Linux Installation

To efficiently install DEWETRON software on Linux, ensure compatibility with either RHEL or
Ubuntu as your operating system. Depending on your DEWETRON software version, verify the
appropriate OS version. Follow these streamlined steps for installing DEWETRON Explorer:

1. Download the correct OS-specific installer from ccc.dewetron.com/pl/oxygen.

2. Open your terminal and navigate to the installer directory

3. Unpack the installer with:  gzip -d dewetron-apps-*.install.gz

4. Run the installer: sudo chmod +x ./dewetron-apps-*.install
sudo ./dewetron-apps-—*.install

The process should complete shortly. Note that on Linux, there's no need to uninstall previous
DEWETRON software versions before installing new ones.
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2 Getting Started

The DEWETRON Explorer is a stand-alone software, which acts as a device manager for DEWETRON
hardware and offers multiple functionalities. In addition to the automatic detection of all connected
devices, the three main features are:

1. check hardware functionality (Chap. 3)
2. update TRION board firmware (Chap. 4)
3. simulate DEWEx- and TRION hardware (Chap. 5)

These key features are discussed in more detail in the corresponding chapters. First of all however,
lets get started with the GUI and its basic structure. Fig. 2.1 shows an example of the DEWETRON
Explorer GUI with a connected device highlighting different sections of the GUI:

@ Menu Bar @ Toolbar @ Hardware-tab @ Demo-tab
DEWETRON Explorer

¥ DEWETRON Explorer — ] X
|Fi|e Local Hardware  Demo  Help ’@
v ©°— 0 [ :

O =T o & e ® o

Exit  Settings MNode Options Self Test Firmware Update Show system report

Hardware Il Demo I@

® Local System

Empty-Enclosure

w @ Remote System
# MNode Mame: CE230020

= » # Node Info
~ Enclosure 0: NEX[DAQ]-1000
CE230020 > #= Enclosurelnfo
il NEXIDAQ]-1000 > [ Slot1: NEXDAQ-1000

IP: 169.254.203.2

Figure 2.1: DEWETRON Explorer example GUI screen.
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2 Getting Started

2.1 Menu Bar

The menu bar provides access to various commands and features grouped into menus. The following
menus are included:

File

= Exit: Button to exit the software. If changes have been made it triggers an automatic prompt
that asks to save changes. This function is also accessible via the toolbar.

= Settings: This button opens the settings menu. This function is also accessible via the toolbar.
For a detail description see Sec. 2.2.

Local Hardware

» Save Configuration: Saves the current configuration.
» Logging Configuration: Opens the Log Settings menu, allowing detailed configuration of
local system logging for the TRION API.

Demo

» Load Demo System from File: Loads an existing Demo System setup from an *.xml file.
Save Demo System to File: Saves the selected Demo System setup to an *.xml file.

Use Selected System as Demo: Uses the active Hardware setup as Demo System setup.
Save Selected System to Demo File: Saves the currently used Hardware setup to a demo
file (*.xml file).

Sample Generator: Choose between Auto and Pre-initialized.

Auto: Generates samples for demo signals in OXYGEN live during operation.

Pre-initialized: Used when live generation of samples is not feasible, especially with 10 MS.

In this mode, the ring buffer is pre-initialized and the signals are played back instead of being
recalculated during operation.

Help

= Software Versions: Displays the current versions of DEWETRON Explorer, DEWETRON
TRION API, and further related software.

= About: Provides basic information about DEWETRON Explorer

» About Qt: Provides details about the Qt framework used in the application.

2.2 Toolbar

The toolbar provides access to various functions and settings via several buttons. The availability of
the individual buttons depends on the connected and selected devices. Nevertheless, the following
buttons are permanently available:

s Exit = Settings = Show system report

Connecting specific devices and modules as well as selecting certain panels in the hardware area will
display additional buttons in the toolbar and hence enable further features. These features include:

» Node Options » Firmware Update = Board Configuration
= Self Test = Feature Update

DEWETRON Explorer 7



2 Getting Started

Toolbar

O =T < & T & B O

Exit  Settings Node Options Self Test Firmware Update Board Configuration Feature License Show system report

Figure 2.2: Available buttons/functions in the toolbar.

2.2.1 Exit

Button to exit the software. If changes have been made it triggers an automatic prompt that asks
to save changes. Also accessible via the "File" menu in the menu bar.

2.2.2 Settings

The "Settings" button opens the settings menu (Fig. 2.3; left panel), providing access to various
options. Within the section General, you can customize the color theme of the DEWETRON Explorer
to suit your preferences. The section TRIONet Network enables the configuration of TRIONet
Networks. For detailed TRIONet network specifications, refer to the TRIONet3 Technical Reference
documentation.

In the section Developer Options, it is possible to override system hardware with simulated (demo)
hardware. Note that this will prevent automatic recognition of local hardware. Additionally, the
Developer Options allow you to display factory settings, although this is not recommended unless
explicitly advised. The settings menu further includes Log Settings (Fig. 2.3; right panel), which
allow detailed configuration of the local system logging of the TRION API.

The settings menu can also be accessed via the "File" menu in the menu bar.

X Settings X
-0— X Dpialog ? X
—O- Settings
-0— .
1z| Local System Logging
Color Theme default v File Name
DeWeTrion.log
TRIONet Network
Logging Level
Network Interface: AUTO v LogOnError
1P Address: Log type
Normal
Subnet Mask:
Write Mode
Developer Options Append v
() simulation overrides hardware Maximum Log File Size (0 equals unrestricted)
() Show factory settings 100 MB
‘ Collect data
Log Settings ok Cancel
Figure 2.3: Left: Settings menu; right: Log Settings
.
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2 Getting Started

2.2.3 Show system report

The "Show system report" button opens a new window displaying basic system information. These
information can be exported to a *.txt file using the "Save" button, which is required for a license
upgrade. For more details, refer to Sec. 6.2.

Show system report

X System Overview X

@ System Overview

Board Name: Base Name  Base Version Feature Base Serial Base CalDate  Con Serial

TRIOM3-CONTROLLER.  8200000C 00100 70000000 A1228883  01.03.2018
TRIOM3-1320-ACC-3-MD 02000010 00100 A4240008 11.10.2023
TRIOM3-AOUT-8 02000000 00100 00000000 A1236491 15.04.2024
TRIOM3-1320-ACC-3-MD 02000010 00100 A4240001  11.10.2023

Figure 2.4: Show system report menu.

2.2.4 Node Options

The "Node Options" icon is accessible only when a DEWETRON front-end device is connected
to the system. Clicking this button opens the node options menu (Fig. 2.5), providing configu-
ration settings for the connected front-end. It allows users to reboot or restart the node, modify
the node's IP address and name, and update the front-end device's software. For detailed instruc-
tions on updating your device properly, refer to the respective device manual. Additionally, all of
these settings can also be customized by right-clicking on the front-end device in the "Hardware" tab.

Node Options

X Node Options x

=
o | fe

Figure 2.5: Node Options
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2 Getting Started

2.2.5 Self Test

The "Self Test" button becomes available either by selecting the "Enclosure" or any mounted slot in
the hardware section. This button opens the "Self Test" menu for functionality checks on plugged
hardware. Refer to Chapter 3 for a comprehensive description.

2.2.6 Firmware Update

The "Firmware Update" button becomes available either by selecting the "Enclosure" or any mounted
slot in the hardware section. This button opens the "Firmware Update" menu allowing you to update
the firmware of the plugged hardware. Refer to Chap. 4 for an comprehensive description.

2.2.7 Feature License

The "Feature License" button is available for hardware devices with adjustable features and opens
the feature license menu. Fig. 2.6 shows an example using a DEWE3-A4 TRION3-CONTROLLER
(Chassis controller). The menu provides information on currently active license features and allows
for remote license upgrades on DEWETRON devices. For a detailed guide on upgrading a license,
refer to Section 6.2.

Feature License

X Feature License *

@ Feature License

Insert License Code

ﬁ###iﬁ###*####*##ﬁ#*####*#ﬁ######ﬁ#{ ‘

TRION3-CONTROLLER A1228B883

Feature Name Value

1 CAN Channels CAN
2 |IRIG and FTP Option IRIG and PTP
3 GPS GPS

4 MCU Option MCU enabled

Figure 2.6: Feature License menu for TRION3-CONTROLLER.

2.2.8 Board Configuration - TRION3-1802/1600-dLV-32

For the TRION3-1600-dLV-32 and TRION3-1802-dLV-32 an additional "Board Configuration" button
becomes available, when selecting the module in the hardware section. This button opens the "Board
Configuration" menu, allowing to switch between single-ended and differential modes.

DEWETRON Explorer 10



2 Getting Started

Board Configuration

X DEWETRON Explorer - a X
Local Hardware  Demo /—_——\
) E £ B E
O 3= @ @) ® X Board Configuration x
Ext  Settings Self Test Board C son | Feature License  Show system
Hardware  Demo \ -O0—
<+ B Remote System —0- Board Configuration
Local System B -o—
Empty-Enclosure i NodeName: TRIONet3 1433
> i NodeInfo
Board Features
“ Enclosure 0: TRIONet3
TRIONet3_1433 > i Enclosurelnfo Feature Name Value
Sy TRIONES > 1 AL Channels ‘31 Channels, Single ended -
IP: 169.254.95.123 Sot 2 Emply

16 Channels, Differential

Local system s in demo mode.

Figure 2.7: Board configuration menu for TRION-1802-dLV-32-D.

2.3 Hardware section

Fig. 2.8 highlights the hardware section. The left panel displays all connected devices. In this case
this includes the local system (PC) and a connected front-end system (NEX[DAQ)]). The right panel
displays detailed information about the selected device, such as system specifications, connected
modules, and MSIs. Use the drop-down arrows to expand or minimize the displayed information.

Hardware section

Y DEWETRON Explorer

(m] X
File Local Hardware Demo Help
Hh = g B ®
O = €
Exit  Settings MNode Options Selff Test Firmware Update  Show system report

Hardware Demo

a4 @ Remote System

Local System
Empty-Enclosure # Node Name: CE230020
— > i Mode Info
~ Enclosure 0: NEX[DAQ]-1000
CE230020 > ¢ Enclosurelnfo
£i1l1} NExIDAQI-1000 > g slot1: NEXDAQ-1000

IP: 169.254.203.2

Figure 2.8: Left: List of all devices detected; right: Details on selected device.
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2 Getting Started

2.4 Demo section

Click on "Demo" to switch to the Demo section. This enables the simulation of any DEWETRON
device including all available TRION modules. We describe this feature in more details in Chap. 5.

DEWETRON Explorer 12



3 Hardware Functionality Check

The hardware functionality check, also known as the self-test function, is designed to verify all features
of an TRION module and perform a complex analog accuracy check. This function is particularly
useful for critical measurements, as it can be conducted both before and after the measurement to
ensure that the hardware is functioning properly throughout.

To initiate a self-test, select the measurement system and click either on "Enclosure" to test the
entire hardware or select a single slot. Then, click on the "Self Test" button in the menu bar or
via the right-click menu. This will launch the Self-Test window, as shown in Fig. 3.1. This tool
offers several different functions, described below. Additional module-dependent functionalities can
be found in the TRION series module manual.

Hardware Tools: Self Tests

¥ DEWETRON Explorer - O X

File Local Hardware Demo Help

O = < Bl & O

Exit  Settings Mode Options |Self Test] Firmware Update Show system report

Hardware Demo \

x Hardware Tools: Self Tests J >

/‘ Hardware Self Test

Slot  3(2): TRION3-1820-MULTI-4-D
Self Test
Excitation Test
Auto Zero
Gain Cal
Reset Default
Save Single Save All Close

Figure 3.1: Self Test menu showcasing its available functions.
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3 Hardware Functionality Check

3.1 Self Test

The "Self Test" function is based on an integrated self test circuit of the selected TRION module.
Overall, the function is designed to verify all features of the board. However, depending on the
module, the scope and complexity of the test may vary substantially. For detailed information, refer
to the respective module in the TRION modules reference document. An example for a successfully
completed self test is displayed in the left panel of Fig. 3.2.

3.2 Excitation Test

This function applies 1 V and 5 V to the excitation terminals. By reading back the excitation with
the input amplifier, it checks if the excitation circuit is working correctly. For correct execution, no
load (devices, sensors, etc.) must be connected. Note that the "Excitation Test" is only applicable
to TRION(3) MULTI modules.

3.3 Auto Zero

The "Auto Zero" or "Amplifier Balance" function eliminates automatically all internal amplifier off-
sets. It switches the differential amplifier inputs IN+ and IN- to the internal GND reference point.
Consequently the offset of the module is adjusted to zero for all ranges. This function can take
up to 4 seconds. It allows compensating the long term zero drift, as well as temperature drifts of
the amplifier. The determined offset correction values are stored in the user memory section of the
EE-Prom. An example for a successfully completed "Auto Zero" function is displayed in the middle
panel of Fig. 3.2.

3.4 Gain Cal

The "Gain cal" function is an adjustment function. It applies the internal calibration source to
all channels. The measured error is used as a calibration factor for correcting the measurements.
These correction factors are stored in the user memory section of the EE-Prom. An example for a
successfully completed "Gain Cal" function is displayed in the right panel of Fig. 3.2.

Hardware Functionality Checks

X Hardware Tools: Self Tests X | | X Hardware Tools: Self Tests X || X Hardware Tools: Self Tests X
~ e Te@ Siot 1; TRION 2403 MULTI 4D; PASSED 1A || suprest ~ Auto Zero@ Siot 1: TRION 2402 MULTI4D: PASSED  ~| | surrast ~ GainCal@ Siot 1: TRION-2402 MULTI4-0: PASSED. A || suramt

~Base: PASSED v CHI: PASSED ' CHI: PASSED
LM73 Base [tries: 1]: PASSED _ ~ AmplifierBalance 125 V: PASSED ~ ADC 125V: PASSED
TriggerLineEnable [tries: 1): PASSED w Offset; -0.001757 (True Value: 0V, Test Result.. Excitaton Test Offset: -0.00001 V (True Value: 0V, Test Resul.. Excitaton Test
GAD-4 [tres: 11 PASSED AmplifierBalance 50 V: PASSED Gain: 1000147 (Limit: 05 %, Meas Gain: 10...
PLL [tres: 1): PASSED AmplifierBalance 20 V: PASSED ADC 20V: PASSED
PortExpander Chd [tres: 1]: PASSED Auto Zero AmplifierBalance 10 V: PASSED Auto Zero ADC10V: PASSED Auto Zero
PortExpander Chi [tris: 1]: PASSED AmplifierBalance 5V: PASSED ADC 2V: PASSED
PortExpander Ch2 [tries: 11: PASSED Gain Cal AmplifierBalance 2 V: PASSED Gain Cal ADC 0.5V: PASSED Gain Cal
PortExpander Ch [tres: 1]: PASSED AmplifierBalance 1 V: PASSED ADC 0:1V: PASSED
CMR Poti Cho tries: 1]: PASSED ResetDefaut AmplifierBalance 05 V: PASSED Reset Defautt v CH2: PASSED ResetDefauit
CMR Poti Ch1 [tres: 1}: PASSED AmplifierBalance 02 V: PASSED ADC125V: PASSED
CMR Poti Ch2 [tres: 1}: PASSED AmplifierBalance 0.1 V: PASSED ADC 20V: PASSED
CMR Poti Ch3 [tres: 1}: PASSED AmplifierBalance 0.05 V: PASSED ADC10V: PASSED
Dusl DAC ChO [tres: 1]: PASSED AmplifierBalance 0.02 V: PASSED ADC 2V: PASSED
Dusl DAC Chi [tries: T]: PASSED AmplifierBalance 0.01 V: PASSED ADC05V: PASSED
Dusl DAC Ch2 [tries: T]: PASSED AmplifierBalance 0.005 V: PASSED ADC0.1V: PASSED
Dusl DAC Ch3 [tries: T]: PASSED v CH2: PASSED v CH3: PASSED
1-Wire Master Ch [tries: 1}: PASSED AmplifierBalance 125 V: PASSED ADC125V: PASSED
1-Wire Master Ch1 [tries: 1}: PASSED AmplifierBalance 50 V: PASSED ADC 20V: PASSED
1-Wire Master Ch2 ries: 1}: PASSED AmplifierBalance 20 V: PASSED ADC10V: PASSED
1-Wire Master Ch3 [fries: 11: PASSED AmplifierBalance 10 V: PASSED ADC 2V: PASSED
CAN-CAL PortExpander Cho [tries: 1): PASSED AmplifierBalance 5 V: PASSED ADC 05V PASSED
SRAM: PASSED AmplifierBalance 2 V: PASSED ADCO:1V; PASSED

~ CAN: PASSED v AmplifierBalance 1 V: PASSED v ~ CH4: PASSED v

Save Single Save All Close Save Single Save All Close Save Single Save All Close:

Figure 3.2: Successful hardware functionality test of a TRION-1620-ACC-6-BNC.
Left: Self Test; Middle: Auto Zero, Right: Gain Cal
\
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3 Hardware Functionality Check

3.5 Reset Default

This function clears all correction values stored in the user memory and resets them to default values.

3.6 Save Single / Save All

These options allow you to store either a single or all test results in an . XML file on the internal
HDD.
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4 Firmware Update

The firmware for each TRION module is bundled with the TRION hardware driver. If a newer
firmware version is available, DEWETRON Explorer will automatically detect it and display a notifi-
cation next to the affected module.

To update the firmware, select the relevant measurement system and click on "Enclosure" to update
all hardware, or choose a single slot. Then, click the "Firmware Update" button in the menu bar or
use the right-click menu. This action opens the Firmware Update menu (see Fig. 4.1), which shows
the currently installed firmware version, the latest available version, and further information. To
begin the update process, click the "Update" button. If an update fails, you can attempt to resolve
the issue by clicking the "Retry Failed" button. After completing the update, shut down the system
and disconnect the power plug for approximately 5 seconds. Restarting the system will finalize the
firmware update process.

Firmware Update menu

X DEWETRON Explorer - ] X

File Local Hardware Demo Help

O < Bl T | O

Exit Settings Node Options Self Test | Firmware Update | Show system report

Hardware Demo

Local System ~ IQ! Remote System
Empty-Enclosure i Node Name: CE230020

— » i Node Info
v Enclosure 0: NEX[DAQJ-1000

3 X Firmware Update x

A
=N Firmware Update

Board BaseModel Component Installed Latest Status Result Info
NEXDAQ-1000 §4DUDUDUD EBase 0051 0051 Current

Please do not switch the boards off during the update process!
Power cycle the system after the Firmware update!

Update Retry Failed Close

Figure 4.1: Firmware update menu showcasing up-to-date NEX[DAQ)] firmware.
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5 Demo System Simulation

In the Demo section, you can configure a complete simulated DEWETRON system, enabling simu-
lation of any DEWETRON device alongside combinable TRION modules. Figure 5.1 illustrates the
demo screen: @ presents the currently simulated devices with selected modules, while @ lists all
objects (devices or modules) that can be added.

Demo screen

[ Y DEWETRON Explorer - O x

File Local Hardware Demo Help

O 5 O
o

Exit Settings Show system report

Hardware Demo

i D Demo System Add Remove
v Enclosure 0: DEWE3-PAS
» i= Enclosurelnfo Al o
» = TRION3 Controller
> |5 slot1: TRION3-1810M-POWER-4 DEWEZ-A4
Eli Slot 2:  Not Accessible DEWEZ-A4L
> Ip slt3: TRION-TIMING-VS DEWEZ-A7
E DEWEZ-A13
> B Slot 41 TRION3-1820-MULTI-4-D DEWEZ-M4
i Slot 5 Empty DEWE2-M4s
Slot 6: Empty DEWE2-M7
slot 7: Empty DEWE2-HM7s
DEWE2-M13
Slot 8: Empty DEWE2-M13s
~ Enclosure 1: TRIONet3 DEWEZ-M18
» i= Enclosurelnfo DEWE2-PAT
Slot 1: Empty DEWE3-A4
Slot2: Empty DEWES-A4L
DEWES-M4
DEWES-MBS
'_-_,-..-———-
@ @ SkEH
o Jmmm

Local system is in demo mode.

Figure 5.1: Demo screen.

.

To add a new device, follow these steps:

1. Click on "Demo System" in subwindow @

2. Select a device from the object list @ and click "Add".

3. Click on an empty module slot. If unavailable, open the drop-down menu.
4. This action will switch the device list to the module list.

5. Choose the desired module and click "Add".

To remove a device or module:

DEWETRON Explorer



5 Demo System Simulation

1. Select the object and click "Remove".
2. For modules, this action empties the slot.
3. For devices, it removes the device along with all its integrated modules.

To change a device or module:

1. Remove it and add a new one.
2. Or, simply click "Replace" to swap it with the currently selected object from the object list.

5.1 Additional module specific settings

5.1.1 Power Modules

All TRION(3)-18XX-POWER modules are equipped with a number of exchangeable sub-modules.
Therefore, these sub-modules can also be defined in a simulated system. To do so follow the
subsequent steps:

1. Open the drop-down menu of your power module, and further open the tab "ChannelProper-
ties". This will list the available channels of your selected power module.

2. Open the drop-down menu of your desired channel.

Right click on "ChannelModule" and open the module settings.

4. Select the desired sub-module and click "Apply".

Sub-module selection

X DEWETRON Explorer — m] X

w

File Local Hardware Demo Help

Yo
=

Exit  Settings Show system report

Hardware — Demo

~ D Demo System
~ Enclosure 0: DEWE3-PAS
» #= Enclosurelnfo .
# TRIONS Controller B

>
v |

L Slot 1: TRION3-1810M-POWER-4 ‘
> = Frmware xcmnne\ Module Configuration X
» i= BoardInfo
> i~ BoardFeatures
» i= ChannelModuleList Channel Module: TRION-POWER-SUB-dLV-1 v
> 4 BoardLocation > TRION-POWER-SUB-dLV-1
v i ChanmelPropert TRION-POWER-SUB-CUR-20A-1
i (ChanneProperties TRION-POWER-5UB-CUR-24-1
v oA Cance TRION-POWER-SUB-CUR-14-1 Apply
. Y . » TRION-POWER-SUB-CUR-024-1
= ChannelModule: TRION-POWER: SIJB—dLVL‘ TRION-POWER.SUB-GLV-1v
5 #= Mode: Voltage S TRION-POWER-SUB-dLV-5V
= Used: True; False TRION-SUB-5V
) TRION-SUB-600V
= All TRION-SUB-XV

i A2 ]
= A3

i A%

i AIS

= Als

i AI7

#= SimulationInfo
Slot 2 Mot Accessible

Figure 5.2: Sub-module selection for power modules.

INFORMATION

For a visual guide on setting up demo systems, check our tutorial video or training presentation.
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6 Additional specific information

6.1 DEWETRON Explorer and OXYGEN

OXYGEN is DEWETRON's user-friendly measurement software and is tightly interlinked with the
DEWETRON Explorer when TRION hardware is utilized. To access devices based on TRION
firmware, they must first be detected within DEWETRON Explorer. If a TRION device is not
detected within DEWETRON Explorer, it will also not be detected within OXYGEN. Therefore, if a
TRION device is not recognized within OXYGEN, ensure its availability within DEWETRON Explorer
first.

Based on the linkage of these two applications, there are some important considerations when work-
ing with OXYGEN and DEWETRON Explorer. Firstly, note that both programs cannot be used
simultaneously, as a TRION device can only interact with one application at a time. Attempting to
use both programs simultaneously will result in an error message. Depending on which software was
initialized first, you may encounter either an OXYGEN warning stating " A\ TRION API locked by an-
other process! (ERROR_HARDWARE_ALREADY_IN_USE)" or a DEWETRON Explorer warning
stating "TRION hardware is used by another application. DEWETRON Explorer will not be able to
display local TRION boards."

Secondly, simultaneous usage of actual hardware systems and simulated demo systems is not possible
in OXYGEN. OXYGEN cannot distinguish between virtually created demo systems and physically
connected instruments. Even though OXYGEN will recognize both systems at once, it will not be
able to acquire any data from neither systems. The warning " A\ Waiting for sync" will be displayed
in OXYGEN. Therefore, any created demo system must be removed when actual hardware is used.

6.2 Upgrade Chassis Controller License

With TRION R7.2, additional chassis controller hardware options for the TRION3 CONTROLLER
can be activated remotely via a license file, eliminating the need to send in the device for upgrades.

Requirements
A remote license upgrade requires that the chassis controller hardware is already installed in the
DEWETRON device. Hence, ensure that the TRION3 CONTROLLER is already installed.

Step-by-step guide
In order to create a license file, specific information about the system is required, which needs to be
exported via the "Show system report" menu. Therefore:

1. Click on "Show system report" within the toolbar.
2. Click "Save" and export all system information to a *.txt file.
3. Send the exported *.txt file to DEWETRON as part of the upgrade order.

DEWETRON Explorer
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Upgrade Chassis Controller License - System Report
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Figure 6.1: Export of system information via the "Save" button in the "Show system report"
menu.

\

After successful submission of the upgrade order, you will receive a license file which needs to be
installed. For a successful installation:

4. Selected the TRION3 CONTROLLER in the right panel of the hardware section
5. Open the Feature License menu.

6. Enter the license key from the license file into the designated field.
7. Click "Apply" and the upgrade is then complete.

Upgrade Chassis Controller License - Activate License

Y DEWETRON Explorer

Fie Local Hardware Demo HEIp

O]

Exit  Settings SaIFTast F\rmwaraUpdate

o
—o
o—

@ )

/_\

sysbem report

X Feature License

©oslot2:

= Endosurelnfo
v i= TRION3 Contraller

Segment : TRION3-CONTROLLER
B Slot1:

=\

TRION3-1820-MULTI-8-L0B
Empty

Hardware  Demo FJ )
— v W ol ysion Feature License

L=t v Endlosure 0: DEWE3-A4

e

Insert License Code

REBBBERE-BELR-LHBR-RERH-RRBL R RHRY

© Sota Enpty TRION3-CONTROLLER A1228883
% Slot4: Empty Feature Name Value

1 CAN Channels CAN

2 IRIG and PTP Option IRIG and PTP

3 6Ps GPs

4 MCU Option MCU enabled

Local TRION hardware found.

Figure 6.2: Enter key into the "Insert License Code" field within the "Feature License" menu
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Each license key is bound to the serial number and is therefore only valid for the respective
chassis controller!
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